yir  QPSLA

CONFERENCE

Building Service-Oriented Architectures (SOAs)
with Web Services
OOPSLA 2008 — Tutorial 12

Olaf Zimmermann
IBM Research

Updates available from: http://www.soadecisions.org

Building SOAs with Web Services

Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

readme.txt

Terms and Conditions of Reuse

= This is the handout material for OOPSLA 2008,
© Olaf Zimmermann, Mark Tomlinson, Stefan Peuser,
IBM Corporation and Springer-Verlag 2003-2007
(except if indicated otherwise on individual slides).

= As the copyright is held by the author/owner(s) of the referenced
material, any form of reuse requires explicit written permission from
the authors/owner(s).

Request for Feedback
= We welcome feedback — good or bad — on the contents of the
presentation. Drop us a note at info@perspectivesonwebservices.de

This presentation contains excerpts from the book “Perspectives on Web services” by Olaf Zimmermann, Mark Tomlinson, and Stefan Peuser,
Springer-Verlag Berlin Heidelberg New York 2003, ISBN 3-540-00914-0.

This work is subject to copyright. © Springer Verlag Berlin Heidelberg 2003. All rights reserved. This material must not be published as a whole
or in part without permission.

Building SOAs with Web Services

Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.



Building SOAs with Web Services

Tutorial Introduction
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Abstract

= Service-Oriented Architecture (SOA) concepts and Web services technologies
have matured into highly attractive architecture and implementation alternatives
for building distributed systems. SOA concepts and Internet protocol-based
implementation stacks are a powerful combination that is well-suited for crafting
helterogeneous business-to-business and enterprise application integration
solutions.

= In this tutorial, we introduce SOA as an architectural style defined by patterns
such as Enterprise Service Bus (ESB) and service composition. We present two
industry case studies that demonstrate where and how these patterns can be
applied in practice. Next, we present selected elements of the Web services
technology standards stack from an application programmer's perspective, for
example SOAP and WSDL.

= In a third module, we design and develop a complete sample application
applying the introduced concepts and technologies, making use of the Web
services editors and code generators in the Eclipse Web Tools Project (WTP).
We conclude with a discussion of the key architectural decisions on SOA and
Web services development projects — for example REST vs. SOAP message
exchange; service interface creation process and granularity concerns; security,
reliability and other quality-of-service factors; server-side deployment and client-
side invocation guidelines. This discussion centers around the lessons learned
on large-scale industry case studies.
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Tutorial positioning

= Attendee background:

» The tutorial is targeted at practitioners with general background in
software engineering and object-oriented programming; familiarity with
XML and Java is a plus.

= Tutorial objectives:

» The tutorial is aimed at software architects wanting to design end-to-
end SOAs and developers wanting to develop and deploy Web
services requestor and provider applications. Attendees will develop an
understanding of the principles and patterns defining SOA as an
architectural style, and will learn how to leverage open source tools
such as Apache Axis to create Web services descriptions, server-side
stubs, and client-side invocation proxies for several languages.
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Instructor(s)

= Olaf Zimmermann is an Open Group Master Certified and IBM
Senior Certified IT Architect and Research Staff Member. His .
areas of expertise include distributed computing and Service- g . o

Oriented Architecture (SOA) in general and Web services in /> Siofan puser
particular. Perspectives on

Over recent years, Olaf has conducted numerous SOA/Web
services engagements, and educated practitioners around the
world on this technology. He is an author of the Springer text
book "Perspectives on Web Services®, ISBN 3-540-00914-0.
Olaf also contributed to several IBM ITSO Redbooks such as
"Web Services Wizardry with WebSphere Studio Application

Developer", SG24-6292-00. Olaf holds a graduate degree =

"Diplom-Informatiker” (awarded with distinction) in Computer Weh Services Wizardry
. . . . . with WebSphere Studio
Science from the Technical University in Braunschweig, Application Developer

Germany.
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Agenda

= Module 1: Introduction to SOA
» Defining principles
» SOA patterns: enterprise service bus, service composition

= Module 2: Introduction to Web Services
» SOAP and WSDL
» JAX-RPC and other Java standards

= Module 3: Developing Web Service Provider and Requestor Applications
» Java and PHP

= Module 4: Putting the ‘A’ back in SOA
» Module 4a: SOA decision modeling concepts and tool support
» Module 4b: SOAP, WSDL, and SOA best practices

Building SOAs with Web Services
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Building Service-Oriented Architectures
with Web Services

Module 1: Introduction to SOA

There have been other
distributed computing models,
but this time it’s serious.

This is just another reinvention
of the wheel, the most pointless
hype in years.
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Objectives and agenda for module 1

Learning Objectives:
= Understand the motivation and market forces behind SOA
= Learn which architectural principles define SOA as architectural style

= Get an overview of SOA patterns and how they are applied in the industry

Agenda:

1. Motivation

2. Defining principles

3. SOA patterns and case studies
4. SOA and Web services market

5. Summary and discussion

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Module 1: Agenda

= Motivation for SOA

= Defining principles

= Key SOA patterns and project examples
= SOA and Web services market

= Summary and discussion
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SOA - hype vs. reality

= Google search for SOA: 30 million hits; Amazon.com: 13,729 books (07/2007)

Advanced Search
Google o o
Web News Blogs Results 1 - 10 of about 29,500,000 for SOA. (0.04 seconds)
|BM SOA - Konzepte Sponsored Links Sponsored Links

www.ibm.com/ch/soa Mehr Flexibilitat durch abgestimmte Geschaftsprozesse - Hier Infos! Free SOA Research Report

= Refined to technical essentials, as taught in this tutorial: 263 hits; 0 books

" Ady d Se h
GOOS[C SOA pattern ESB style"] [ Search | Adianced Search
Web Restis 1 - 10 of about 263 for SOA archi pattern ESB "arch style” i ion ESB BPM. (0.35 seconds)

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

General challenges in enterprise application development

= Many users and backend systems interact with the system
» Numerous functional and technical entry channels
» Custom applications and software packages to be integrated

= Sophisticated Quality of Service (QoS) requirements and other
Non-Functional Requirements (NFRs), for example:

» Response times to be guaranteed, even under heavy load
» Transactional integrity in long-running workflow scenarios

= Hardly any green field
» Multiple technology stacks, stovepipe architectures, interface spaghetti

» Valuable data and business logic in systems that have been developed
under tight budget and scheduling constraints

The only constant is change
» Requirements, technology, environment dynamics

Building SOAs with Web Services
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Typical status quo in many enterprise IT architectures

= Functional and technical application monoliths ubiquitous

» Stovepipe architectures, application scope creep, redundant
implementations, data management and many other agility issues

» Architectural governance or guidance missing

= Development and integration projects costly and long running
» Proprietary point-to-point connections, often developed from scratch
» File transfer is a frequently used integration pattern with numerous
architectural drawbacks

» Roll-your-own philosophy works short term, but leads to maintenance
headaches

= As aresult, horizontal initiatives are much harder to implement
than they have to be

» Example: single customer relationship management solution on top of
several line-of-business applications (packages and custom developed)

Building SOAs with Web Services
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Solution: Evolve and integrate former monoliths into a
Service-Oriented Architecture (SOA) ecosystem

Service-Oriented

Component-Based Architectlfr_e

Development Enterprise Application
Integration (EAI)

Messaging Backbone AL “ %

¢ = Integration and choreography of
services through an Enterprise
= EAIl connects applications Service Bus
via a centralized hub = Flexible connections with well
= Easier to manage larger defined, standards-based
= Point-to-Point connection number of connections interfaces

between applications
= Simple, basic connectivity

Source: [IBM SOA]

Building SOAs with Web Services
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SOA fundamentals: Modularity, layering, and loose coupling

Traditional SOA -
Users .

1T ervices
u ) .H. 28909 'F*?‘(?V V -
| $9990%060000
‘- Services ‘ ‘ Components
Logic O ‘ :
Data () .

299999

Discrete Applications P
(Two or Three Tiers) Basket of Services Layering based on [IBM SSS]

Example:
An insurance company uses three SAP R/3, MS Visual Basic, and COBOL applications to manage customer
information, check for fraud, and calculate payments. The user interfaces (Uls) are the only access points.

A multi-step, multi-user business process for claim handling, executing in IBM WebSphere, is supposed to
reuse the functions in the existing applications. How to integrate the new business process with the three
legacy applications in a flexible, secure, and reliable way?

Building SOAs with Web Services
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Module 1: Agenda

= Motivation for service-oriented computing
= Defining principles

= Key SOA patterns and project examples
= SOA and Web services market

= Summary and discussion
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What is a Service-Oriented Architecture (SOA)?

No single definition — “SOA is different things to different people”

Business
Domain
Analyst

» A set of services that a business wants to expose to their
customers and partners, or other portions of the organization.

» An architectural style which requires a service provider, a service
requestor (consumer) and a service contract (a.k.a. client/server).

» A set of architectural patterns such as enterprise service bus,
service composition, and service registry, promoting principles
such as modularity, layering, and loose coupling to achieve design
goals such as separation of concerns, reuse, and flexibility.

Administrator
» A programming and deployment model realized by standards,

tools and technologies such as Web services and Service
Component Architecture (SCA).

Adapted from: [IBM SSS]

Building SOAs with Web Services
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SOA building blocks on the three levels of abstraction

Busine_ss
Business-Aligned Service Descriptions e
(Interface Contracts)
T
Separation of Concerns Loose Coupling Architect
and Modularity and Messaging
Service Repository/ Service Composition Enterprise Service Bus
Registry (Process Choreography) (ESB)
Administrator
Development Execution Runtimes XML & Web Services Internet
Tools (e.g. SCA, J2EE) Standards Protocols

Building SOAs with Web Services
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SOA principle 1: Modularity (a.k.a. separation of concerns)

= Motivation
» Integrating monolithic applications (“stovepipes”) is hard ‘ ‘
(e.g., traditional Enterprise Resource Planning packages) o .
= Solution Service Basket
» Refactor to services, expose service interface only, v
hide implementation details (a.k.a. encapsulation) ‘

= Forces and consequences
» Service contracts have to be defined and interpreted (by tools and/or runtimes)
» Services have to be located and invoked in a coordinated manner
» Service invocations have to be free of undesired side effects (data management?)

= Roots and known uses
» [Parnas] and [Dijkstra] introduce modularization and separation of concerns
» [Meyer] adds formal contracts with pre- and postconditions and invariants
» Component models such as [CORBA], [J2EE], [Jini], and [OSGI] promote the concept

Building SOAs with Web Services
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SOA principle 2: Layering (logical and/or physical)

= Motivation

» Service characteristics such as interface granularity and lifecycle vary:
e.g., technical logging service vs. claim checking business process

29999
99670%edeeee

= Solution
» Organize the SOA into 3++ architectural layers

= Forces and consequences
» More indirections, requiring communications infrastructure
» First law of distribution: “the best remote call is the one you don’t make”

= Roots and known uses
» Seven networking layers defined by [OSI]
» Layers pattern originally described by Buschmann et al. in [POSA]
» Patterns of Enterprise Application Architecture [Fowler]
» e-business, on demand and WBI reference architectures from [IBM SOA]

Building SOAs with Web Services
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SOA principle 3: Loose coupling through messaging

Message
Channe!

= Motivation ((WV\
» Once applications have been modularized, ; 0
IR —

}
dependencies between services occur

. Sender Messaging Receiver
" SO|UtI0n Application System Application

» Couple services loosely (several dimensions) Source: [Hohpe]
» E.g., messaging system decouples in time, location, and language dimensions

= Forces and consequences
» Messaging means single implementation/endpoint by default (no remote objects)
» Receiver is stateless per se, so conversational sessions require correlation logic
» Asynchronous communication complicates systems management

= Roots and known uses

» Enterprise application integration vendors have been promoting the concept for a
long time; origin of term hard to track down [looselycoupled.com]

» Hohpe and Woolf define a pattern language for message-based integration
[Hohpe]

Building SOAs with Web Services
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More SOA principles

= Business-IT alignment and SOA governance

= Model-driven, process-centric development methodology
» Model-assemble-deploy-monitor development lifecycle, industry models

» Formalization of process and service semantics, code generation

= Data- and meta data-centric SOA
» Information as a service (master data management), semantic brokering

= Integrated service management
» Contract-aware service monitoring

» Feedback loop to business modeling

= Standardization and openness of service models and runtimes

Building SOAs with Web Services
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SOA principle n: Service virtualization and flexible infrastructure

= Motivation

» “I don’t care about a particular
provider, just chose the one that —
at this point in time is best for me” Descriptors

Process

= Solution
» From WWW to service bus/cloud

» Two-level programming

= Forces and consequences
» Many open research issues

Source: [Leymann]

» E.g., trust and privacy, precise semantics, QoS, multi tenancy, provisioning

= Roots and first isolated steps
» Software as a service, e.g. Salesforce.com CRM and Amazon storage service
» Dynamic matchmaking, grid and utility computing, on demand

Building SOAs with Web Services
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Module 1: Agenda

= Motivation for SOA

= Defining principles

= Key SOA patterns and project examples
= SOA and Web services market

= Summary
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Layered SOA reference architecture revisited

Several strict and semi-strict logical layering schemes exist; defining service, integration
and process layers is common. [IBM SOMA] adds a component and a QoS layer.

Business process layer
Composition; choreography;

Services layer

Alamic and compasiie

llI23Ul SSBUISNG PUE EjEpERW
Jeke| aauBLIBADS)

J18iB| BINJIBYILAE UDNBULIOW|

2oush

Source:
[IBM SSS]

Some reference architectures define additional layers, for example the IBM
SOA Solution Stack project defines 5+4 layers (semi-strict layering) [IBM SSS].
The service composition and the ESB patterns are two of these layers.

Building SOAs with Web Services
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SOA pattern 1: Enterprise Service Bus (ESB)

A communications “architecture” that enables software applications that run
= on different platforms and devices
= written in different programming languages
= use different programming models
= require different data representations

Disparate programming models

to communicate with no disruption to existing applications or interfaces.
AsynchronousSynchronous Publish/
Messages RPC R Subicribe

P O <.

Enterprise Service Bus

I XML I coBOL
& Copybook
J r+ FIX SWIFT
Java HIPPA ebXML p;3 HL7
m COBOL ACORD ppypacT EDIX.12
- Custom Formats WordI/ExcellPDF
Disparate Disparate Disparate Source:
Platforms & devices Programming languages Data formats IBM SOA]

Building SOAs with Web Services

Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

13



SOA pattern 1: Enterprise Service Bus (ESB)

= Refinement of well-established broker pattern described in [POSA]

» Hub-and-spoke architecture known from many Enterprise Application
Integration (EAI) products, providing many-to-many connectivity between
loosely coupled parties — the ,B‘ in ESB

» Plus explicit, machine-readable service interface contracts — the ,S‘ in ESB

» Plus business alignment and high-end Quality of Service (QoS)
—the ,E'in ESB

= Key capabilities defined in [Keen] and “Enterprise Integration Patterns”
[Hohpe]:
» Multiple transport layers and message exchange patterns:
» Synchronous service invocations, e.g., via simple Web protocols (HTTP)
» Asynchronous messaging (JMS, MQ) — key for loose coupling!

» Mediations providing content-based routing, message format conversions,
instrumentation for QoS management (logging, billing, security controls)

» Declarative, policy-based configuration and management

ul| |

Source: [Hohpe]

Building SOAs with Web Services
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ESB and Web services case study [OOPSLA 2004]

Platform WSDL |
independent A

OAP
ESB
O generate
Web Services Adapter Layer
Java™ API (Dynamic Interface)
3 Java B dc gm p MQ, CICS®) Repository
2 \ /
= R
S
=
©
c
>
(=] Access Layer
i Database generate
¥ ®)
1BM Business Function oo
cics
(zSeries)
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Layered SOA reference architecture revisited

Business process layer
Composition; choreagraphy;
business state machines

Services layer
Alamic and compasite

Biisiu sssusNg pue 2epeiaw
Jafe| IUBLIBADD)

JBiE| BINDEYIYIIE UDJRLLDIU|

20Ul
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SOA pattern 2: Service composition

= The business logic layer of n-tiered enterprise applications can be
divided into two sub-layers (architectural “refactoring”):
» Processing steps assigned to roles placed in process layer
(pattern a.k.a. workflow, business process choreography) g

» Basic computations, validation logic, manipulation of
persistent business entities placed in atomic services layer

Source: [Hohpe]

= Foundations for process layer execution semantics (workflows):
» Business Process Management (BPM), Petri nets, Pi-calculus, [Leymann]

» One technology option is the Web Services Business Process Execution
Language (WS-BPEL or BPEL4WS), standardized by [OASIS]

= Key issues:
» Where to draw the line between the two sublayers?
» How to interface with the presentation layer?
» Integration of legacy workflows, e.g., those residing in software packages?

Building SOAs with Web Services
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Multi-channel order management supporting a wholesaler-retailer business
model in the telecommunications industry [OOPSLA 2005]

Client Browser Channel Client Web Services Channel
= Functional domain: t

Presen-
» Order entry management  tation

» Two business processes. channel
new customer, relocation  controller L weor

BPEL
= Main SOA drivers: usiness LT
. Process
» Deeper automation grade ¢\ Bliclfeas Drotess Brlio
(e.g., compensation) — e ———————————

. s V Il Val
» Services shared within ~ Short Running %—‘m ¢/

. Process Activity
and between domains Activities g et

1 n

Z

= Service composition: Business ast
. Services
» Top-down from retailer

interface and process Application
P L Services Ast Asn

» Bottom-up from existing >

L 2
wholesaler systems Core = el syomn | Business £ - 9
Systems m I .other| Objects ﬂ&g
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UML representation of ESB and BPEL service composition

The core ESB capability is captured by the interfaces duality (IESBRouting, IPortType).
Logically, all service-to-service communication runs through the ESB isolation layer.

«subsystem» > :
F8 = There might be several transport bindings such as local, EJB, SOAP/HTTP, JMS.
Transport, security, and other ESB capabilities defined in [Keen] not modelled here.

«offersy «interface» «uses»
«component» IESBRouting
ServiceA int i viceRequest()
+registerServiceProvider()
«sesr "% «interface» «offers»
IPortType «component»
operation1() | | |ServiceProvider
+operationN()

«subsystem»
BusinessProcessChoreographyServices

«component»
ExposedProcessManager
¢

«compenent»
ServiceRequestor

Existing systems and building blocks from any of the seven SOA layers
can be exposed on the ESB by providing a service interface (IPortType)

«component» «components «compenent» (adapter or facade pattern). See class diagram for service hierachy.
OtherAc <“| BPELFlow InvokeActivity Process choreography merely serves as an example here.

Via invoke activities and the ESB, other services can be invoked. A BPEL invoke activity

A process flow exposes a service interface and therefore is one type of service provider.
is one type of service requestor.

Building SOAs with Web Services
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SOA pattern 3: Service registry

= SOA incarnation of naming and directory services known from
CORBA, J2EE, DCE, and other distributed computing technologies

= Key capabilities:
» Build time service publishing and lookup
* Human user (developer)
* Tools
» Runtime registration and lookup of service providers
» Semantic annotations
» Matchmaking

= Known uses:
» Web services specification: UDDI
» IBM WebSphere Service Repository and Registry (WSRR)

» Most of today’s SOA references use custom built repositories tightly
integrated into inhouse development processes

Building SOAs with Web Services
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General-purpose patterns still applicable in SOA

= All messaging patterns from Enterprise Integration Patterns website
» Message queue, channel, broker, process manager [Hohpe]

= Domain model, service layer, universal language [Fowler], [Evans]
= Distributed computing and remoting patterns [POSA], [Zdun]

= Client-side remote proxy and server-side invocation stub [POSA]
= [GoF] patterns such as factory, singleton, observer

= Security patterns [Schumacher]

= Information integration patterns [Sauter]

Building SOAs with Web Services
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Module 1: Agenda

= Motivation for SOA

= Defining principles

= Key SOA patterns and project examples
= SOA and Web services market

= Summary

Building SOAs with Web Services
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Motivation for SOA and Web services initiatives

= Business drivers
» Customer-focused initiatives involving multiple sales channels
» Merger, acquisition, and divestiture readiness
» Agility and flexibility issues

= Technical reasons

» Web services seen as a a simple and universal connectivity technology for
heterogeneous worlds (B2B and EAI)

» Replacement of proprietary with standards-based technology,
replacement of custom middleware and tools with vendor components

» Sharing of application building blocks across lines of business and
projects (reuse)

» Modernization of enterprise architecture due to maintenance, productivity,
and cost issues

Building SOAs with Web Services
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Widespread interest in SOA concepts and technologies

= Consumers of Information Technology (IT)
» Lines of business in various industries: business-IT alignment, flexibility
» Enterprise architecture groups, other corporate IT functions: governance
» Solution development teams: modularity, layering, loose coupling, patterns
» System administrators: declarative deployment, service management

= Suppliers of IT, e.g., application software and infrastructure vendors
» Open existing applications for new usage scenarios (business model?)
» Middleware, middleware, middleware
» Strong need for tools

= Professional services (consulting) firms
» Process and service modeling methods and practices
» SOA strategy consulting, development, integration, and hosting services

Building SOAs with Web Services
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Some industry incarnations of SOA (in alphabetical order)

Vendor Selected SOA/WS Offering (s)

IBM J2EE application server; SOA is an inherent part of
strategy, products and services. The developer portal
features an SOA and Web services zone:
http://www.ibm.com/developerWorks/webservices

IONA CORBA products and open source and commercial ESBs:
Orbix, Artix, Celtix, see http://www.iona.com/products

Microsoft e.g., .NET SDK, Web Services Extensions (WSE),
Information Bridge Framework (IBF)

Oracle, BEA J2EE application server; SOA infrastructure management
offering: http://dev2dev.bea.com/soa

SAP Enterprise Service Architecture (ESA), NetWeaver:

http://www.sdn.sap.com/irj/sdn/developerareas/esa

Various system integrators SOA practices evolving from EAI/J2EE/BPM base,
and consulting firms e.g., SOA white paper from ThoughtWorks [Hohpe],
available from http://www.eaipatterns.com

Building SOAs with Web Services
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A few of many Web services implementation assets

Language Web Services Support

Java Web services suppport is mandatory since J2EE 1.4
BEA WebLogic
IBM WebSphere

Other J2EE 1.4-compliant application servers
Other commercial offerings

Systinet WASP, registry (acquired by HP)
Open source assets

Apache Axis2, Axis 1.2/1.3, Codehaus Xfire

Microsoft languages Native support in .NET 1.1, Web Services Extensions
(C#, VisualBasic) (WSE), Information Bridge Framework (IBF)

MS Office support via SOAP Toolkit (now deprecated)
Perl SOAP::Lite and others
PHP NuSOAP (SourceForge project)

PHP 5 SOAP Extension (native C implementation)
Ruby Basic support in Ruby on Rails via Action Web Service

Building SOAs with Web Services
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Module 1: Agenda

= Motivation for SOA

= Defining principles

= Key SOA patterns and project examples
= SOA and Web services market

= Summary and discussion

Building SOAs with Web Services
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How do Web services-based SOAs help addressing common
enterprise application development and integration challenges?

Challenge Response

Flexibility and agility Logical layering
Separation of concerns
Matchmaking via bindings rather than name and type

Bridging business-IT gap Business-aligned service models
Business performance management and composition enabled
through WSDL contracts and BPEL

Evolve proprietary Standardized interface contracts (WSDL, semantics, policy)

monoliths into reusable  Integration via ESB

components Split business logic layer into process and atomic service layer

Many legacy Document messaging rather than tightly coupled RPC

applications Interoperable protocols such as SOAP

(no green field) Patterns such as adapter and facade

Time-to-market Increase productivity through standardization and off-the-shelf
tool support

Building SOAs with Web Services

Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Object-Orientation (OO) vs. Service-Orientation (SO)

= 00 and SO share many characteristics, but differences exist as well
» Encapsulation, information hiding through interfaces (OO and SO)
» Remote objects and call stack (OO) vs. document-centric messaging (SO)
» Name and type as linking element (OO) vs. bindings and contracts (SO)

= Rule of thumb: develop object-oriented and integrate service-oriented
(SO on macro level vs. OO on micro level):
» OO is a general-purpose programming paradigm
» SOA is an architectural style for enterprise application integration

» Web services consumers and providers (the enterprise systems to be
integrated) can be OO applications or other

= Service autonomy should be strived for, see [Ferguson]

Building SOAs with Web Services
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Module 1: Concluding thoughts

= SOA is a state-of-the-art architectural style for crafting and
integrating enterprise applications of quality and longevity
— considered to be a “paradigm shift” for the software industry

» Benefits include agility, flexibility, reuse, productivity gains, openness

= On the other hand, SOA comprises many well-established software
engineering principles and patterns (“same old architecture”)

» Some of which are 30+ years old (nothing wrong with that!)

» SOA adopts and combines them for one particular problem domain —
enterprise application development and integration

» Strong emphasis on modularity, layering, loose coupling via messaging

= ESB, process choreography, and service repository/registry are key
SOA patterns; non-SOA patterns continue to be relevant

» Refining general-purpose patterns such as broker, workflow, directory
» Applicable across industries, both internally and externally

Building SOAs with Web Services
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Building Service-Oriented Architectures
with Web Services

Module 2: Web Services Concepts

Web services reuse well-
established and proven
concepts.

I’'ve already skimmed through

H ’
This module is excerpted from the book “Perspectives on Web some WSDL, and I dldn t
services” by Olaf Zimmermann, Mark Tomlinson, and Stefan Peuser, . .
Springer-Verlag Berlin Heidelberg New York 2003, ISBN 3-540- understand a single line.

00914-0. This work is subject to copyright. © Springer Verlag 2003.
All rights reserved.
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Module 2: Agenda

= Building blocks for delivering SOA with Web services
» XML

» SOAP

» WSDL

» UDDI

» Security

» Interoperability
» Java and J2EE

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

While SOA is a conceptual architectural style, Web services
provide enabling technology standards for SOA. /
=

= SOA is an architectural style whose goal is to achieve loose coupling among
interacting software agents through modularization, layering, and messaging

» SOA enables advancement in the programming model, e.g. Service Component
Architecture (SCA), an XML-based deployment model for service providers

= SOA and Web services are not identical (concepts vs. technology):

» Many existing production SOAs do not primarily use Web services — they are built on
Message-Oriented Middleware (MOM)

» Not all deployed Web services-based systems necessarily embrace all the guiding
principles of SOA (e.g., loose coupling through messaging)
Source: [IBM SOA]

Building SOAs with Web Services
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Web services technologies use eXtensible Markup Language
(XML) documents to describe, invoke, and publish services.

Contract
Repository

WSDL: Web Services Description Language
SOAP: (formerly) Simple Object Access Protocol
UDDI: Universal Description, Discovery, and Integration

Service Provider Bind, Service Requester
invoke via
XML
messaging

Provider

Service

Requester
Handler
Internet (Proxy) \ Application

Backend or
Legacy
Application

Web ‘SOAP . Client
Service Application

Module 1 Module 2

Source: [IBM ITSO]

Code for handling

WSDL description

. is ge:!erateq l;{y masslagdai is

inspecting existing . generated from
Source: [IBM [TSO] application Integrated Development Environment (IDE) WSDL description

Building SOAs with Web Services
lowner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Copyright is held by the

Completing the Web services layers (WS-* stack) :
Secure, reliable, transacted Web services

Service
BPEL4WS ‘ compasition
Gomposable
% Reliable . service
Security messaging Transactions assurances
| XSD, WSDL, UDDI, Policy, MetadataExchange || Description
| XML, SOAP, Addressing [[ Messaging |
| HTTP, HTTPS, SMTP || Transpos |

Source: [Ferguson]

= WS-Security suite

WS-ReliableMessaging

= WS-Coordination, WS-AtomicTransaction, WS-BusinessActivity
(under standardization at OASIS and WS-I)

Building SOAs with Web Services
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SOAP/WSDL Web services (WS-* stack) vs. REST

= WS-*: W3C, OASIS, WS-I standardization effort
» SOAP, WSDL, UDDI ... as introduced in Module 2

» Many additional specifications for all areas of concern in enterprise
application development (principle of composability)

= REpresentational State Transfer (REST)

» Lightweight XML over HTTP runtime based on protocol primitives like
HTTP-GET [Fielding]

= Vendor support typically centers around WS-*; many public Web
services are available via both channels, SOAP/WSDL and/or REST

» See Amazon, eBay, Google, Yahoo! Web services for examples

This module focuses on the core of the first of the two approaches,
which is ready for production usage (XML, SOAP, WSDL)

Building SOAs with Web Services
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Building blocks for delivering a service-oriented architecture
implemented with Web services

Discovery
Agency

UDDI/ WSIL

UDDI/ SOAP
Inquiry API

UDDI/ SOAP
Publish API

Lt

Service —e——— Service
Requestor binding and Provider
implementation
Lot

SOAP [ HTTP or other Transports

| Security |

| XML Namespaces | | XML Schema |

| XML Foundation |

Interpretation of the core specifications and links through the WS-I profiles [WSI]

Building SOAs with Web Services
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Building blocks: XML

4T ™
Service | | Service
Requestor Provider
-t >
| XML Namespaces | | XML Schema |
| XML Foundation |

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

XML, XML Namespaces and XML Schema introduction

Anelement  <oxml version="1.0" encoding="UTF-16"?> ¢—— g:l:i:ﬂg‘m
holding an —p<address targetAddress="UK"> = XML [XML]
attribute <name>Ed U.Cate</name>
<street>12 Soap Street</stﬂAﬂ element 4 Markup Ianguage composed of
<city>service City</city> containing tags and data
’—><postal—code>B1 1AA</postal-code> four other i
St </address> N0 T e » Elements and attributes
rt tag taini: End tag
containing » Read by an XML processor
character
data (payload) » Requires grammar definition
XML instance document example » Valid and well-formed

= XML Namespaces [XMLNS]
» Global naming mechanism for XML

» Qualified names: prefix and local parts

XML Schema, DTD
(XML Document
Grammar)

» Multiple namespaces in same document
= XML Schema [XMLSch]
» Provides grammar for XML instance docs

\«v XML Instance,

valid \| Instance Document
Documents

» Built-in types

» Simple and complex custom data types XML document grammar and valid XML instances

Building SOAs with Web Services
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Building blocks: SOAP

4 ™
Service ,| Service
Requestor Provider
Lot

SOAP [ HTTP or other Transports

Building SOAs with Web Services
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SOAP basics: XML documents as service invocation messages

= SOAP message elements: Envelope, Headers, Message Body and Faults
= Two communication styles: Document style, RPC style
= Literal or SOAP encoding of message body plus attachments support

Reference: [SOAP]

<SOAF-ENV:Envelope
xmlns: SORP-ENV="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:xsd="http://www.w3.org/2001/Schema"
xmlns:xsi="http://www.w3.org/2001/Schema-instance™>
<SOAP-ENV:Header>
/<pQE:priority
xmlns:pQP="http://premierquotes.com/ns/priority"
SORP-ENV:mustUnderstand="1"> ‘\
high Header must be processed
</pQP:priority>
</SORF-ENV:Header>

<SOAP-ENV :Body> /
__y<pQ:getEhoneNumber

xmlns:pg="http: //premierquotes .com/ns/employees”
SORP-ENV:encodingStyle=
"http://schemas.xmlsoap.org/soap/encoding/">
<first-name xsi:type="xsd:string">Ed U.</first-name
Method P“mme‘m—s<:<last—na.me xsi:type="xsd:string">Cate</last-name>
</pQ:getPhoneNumber>
</SOAP-ENV: Body>

</SORE-ENV: Envelope> Method parameter types Method parameter values

Envelope

Header entry

Method invocation

Use SOAP

Body entry encoding

SOAP message containment
structure SOAP message example

Building SOAs with Web Services
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Service
Requestor

e ————
binding and
implementation

Building Blocks: Web Services Description Language (WSDL)

™

Service
Provider

Lt

Building SOAs with Web Services
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WSDL basics: XML language for service descriptions

.............................. portType

identical name attributes
or element names

» Containment

Relationship
Linked-to

P Relationship

Logical relationships between WSDL elements

= WSDL document elements
» Type definitions and imports

» Interface description (Port
Type, Operations, Messages)
» Extensible binding section
» Implementation description
(Ports)
= WSDL SOAP binding

» Defines header and fault
support

» Extensibility element for
addressing

= HTTP binding also defined

Reference: [WSDL]

Building SOAs with Web Services
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Building Blocks: UDDI

Discovery
Agency

UDDI/ WSIL

UDDI/ SOAP
Inquiry API

UDDI/ SOAP
Publish API

L
Service | Service
Requestor Provider
- ™

OASIS 9

Building SOAs with Web Services
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Universal Description, Discovery and Integration introduction

Web Service Provider Information
businessKey

= Provides a Web services directory

business

platform
» Businesses and organisations providing pusinessKey ¥ Web Service Information Containmont
Web services P Relationship
serviceKey weeep Linkedto
» Descriptions of the services provided Relationship

serviceKey

» Information about technical interfaces Modellnshncenehils'.-
( ModelKey

= Sophisticated taxonomy bindingKey e .
» in identification m
(SSJ_F:JP_?\‘FEZ ,bgT_N(:S:tcc_’)e tification systems Containment and reference relationship of data structures

» Also supports business and product
classification systems
(UNSPSC, NAICS etc.)

= Contains references to WSDL interfaces
= Programmatic interface
» Posting and requesting service information
= Global operator cloud
» Test and Production registries
= Private internal registry implementations
more frequently used

O Mandatory

‘.
Optional
description O Option
@ Exclusive
Containment
P Relationship

«+++P URIReference

wsDL
Interface

and Binding

Document

Reference: [UDDI] The tModel structure

Building SOAs with Web Services
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4 Lt
Service Service
Requestor Provider
- La

Building Blocks: Security

Security

“$% OASIS 9

Building SOAs with Web Services
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Securing Web services with HTTPS (HTTP over SSL or TLS)

Most Web services providers and
requestors are able to support SOAP
over the HTTPS protocol
This provides message-level integrity
and confidentiality and also provides
an authorisation model
SSL certificates can be requested
from a certificate authority or self-
certified
» Key file and trust file used
» Password-protected certificates
shared between parties
Easy to implement, but has several
limitations
» Message cannot be processed by
intermediaries
References: [SSL, TLS]

HTTPS

Service Requestor Service Provider

Server Certificate

A~ —
Key File

Server-side authentication

HTTPS

Service Requestor 40— Service Provider

Server Certificate

—A 3

Client
Key File

Client
Trust File

Server
Trust File

Client Certificate

Client- and Server-side authentication

Building SOAs with Web Services
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WS-Security specifications
WS-Federation Reference: [WSS]
WS-Secure ws- Aln’:;ﬁ_
Conversation Privacy zation
WS-Security

"; SoAP WS-Trust Eallcy,

5 WS-Policy

_§ Envelope Extensions XML| | Token ||Extensions

g ST wesew 7T e

=

3

XML XML Signature | XML Encryption Ke;('lcllg-;mt
z http, MQ, ftp ...
25 2 | st |
] Ey TCP/IP
E -
F e >
Web Service Foundation Security Extensions
= WS-Security is a building block for security token propagation,
message integrity and message confidentiality which can be
combined with other Web services extensions
= Implementations available today, vendors and open source

Building SOAs with Web Services
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Building Blocks: Interoperability and WS-l.org

Lt

WS-I Basic

Profile 1.1/1.2, =
Attachments WS-I Basic
Profile 1.0 and Security Profile
Simple SOAP 1.0 (March 2007)/1.1

Kerberos, REL, and
SAML
Token Profiles

| Security % i

| XML Namespaces | | XML Schema |

WS | 3 I | XML Foundation |

WEB SERVICES

ORGANIZ ATION WS-I deliverables: profiles, sample applications, testing tools [WSI]

Binding Profile 1.0

Building SOAs with Web Services
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Building Blocks: Java and Web services

T ™
Service ,| Service
Requestor Provider
- s

. Icava
ommunity
EEN Process

Building SOAs with Web Services
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Base architectural building blocks for a J2EE solution
Discovery Agency (incl. Publication Support)
uDDI uDDI Biher
Web Application Database
Service Service Provider
(Client) SOA Core Components & Utilities (s'"d' Inspection
(Wire and Description Stack Support) upport)
JAXR
uDDI4J
[SOAP/JAX-RPC] WSsIL
JAX-WS wsbLa) (decentral)
WsIL4J
SAAJ, JAXM Deployment
(JSR 67) JSRs
WSIF
General Purpose Utilities
J2SE/J2EE Management
LI G (JDBC, J2C, ...) Support

Building SOAs with Web Services
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Java Web services architecture — logical and process view
Stub-based Service Requestor Service Registry
(also a provider)
. Database Registry Code
Client Code (File, RDBMS) (UDDI, WSIL)
1: Find
JAX-RPC/WS | [ SOAP Engine ) Servlet Engine SOAP Engine JAX-RPC/WS
Stub (Axis, other) | | HTTP Client r (Tomcat, other) (Axis, other) Stub
Transport Infrastructure
- Ri Web (HTTP) Network Operating
23 . Bi nd r Server (TCP/IP) System
Stubless Service Requestor I Service Provider
Database Server Code
SGED 2b: Invoke (File, RDBMS) (POJO, EJB)
SOAP Engine
exicloter) Serviet Engine| | SOAP Engine JAX-RPCIWS
HTTP Client (Tomcat, other) (Axis, other) Stub

Building SOAs with Web Services
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JAX-RPC 1.1 API (Java 1.4 and earlier)

1 | U |
1 J2SE X 1 J2EE Container .
1| Client Side | I'| Server Side 1
I'| JAX-RPC Runtime | : JAX-RPC Runtime :
1

1 : 1 Service Endpoint | | |
I L] | ! ]
| Service Service 1 1 Service |
1 Intort Endpoint | |, 1 Endpoint 1
1 ntertace Interface | |; : Interface 1
1 . 1
! I l 1 : Service :
1 . Service . 1 Endpoint

! Sglltvn:te Object CSI:zEt : Implemen- :
: &0 (Factory) 1 | tation X
- : Transport |_ __________ 1

Java XML API for Remote Procedure Calls (JAX-RPC) uses design
patterns such as proxy and factory to provide consumer (client) and
provider (server) side access to SOAP messaging

= Defines WSDL and XML Schema to Java mapping Reference: [JAXRPC]

Building SOAs with Web Services
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JAX-RPC 1.1 and Enterprise Web Services 1.1 (Java 1.4)

________________________________ -
|r J2EE Container 1 : J2EE Container 1
1 .
I Client Side " 1| server side |
: JAX-RPC Runtime 1 1| JAX-RPC Runtime I
1 ! : Service Endpoint | | !
1 ! v ! 1
JNDI - I I |
! Service Service 1 1 Service 1
! Interface Endpoint 1 ! Endpoint 1
: Interface I 1 Interface |
PN B 1 1 1
: l- l 1 1 Service 1
) Service . 1 1 Endpoint 1
: Sglr.v =3 Object Csltlezt ks Implemen- 1
I [t (Factory) u 1 1 tation 1
1 I Transport ‘l
Web
Services = J2EE Extension of JAX-RPC: Services

Client DD Server DD

» Deployment Descriptors (DDs)

» EJBs as service endpoints
Reference: [EWS]

Building SOAs with Web Services
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Java XML API for Web Services (JAX-WS) 2.0 (Java 5)

= Follow-up to JAX-RPC 1.1:
» Support for latest SOAP, WSDL, and WS-I specifications
» SOAP 1.2, WSDL 2.0 (continued support for 1.1 versions)
» WS-I Basic Profile 1.1
» Data binding related tasks now delegated to JAXB 2.0

= Annotations and Web services metadata — JSR 175, JSR 181

» JAX-WS 2.1 defines the use of Java annotations (JSR 175) to simplify
the most common development scenarios for both clients and servers,
and aligns with and complements the annotations defined by JSR 181

» Class level: @WebService(), method level: @WebMethod()

= Extension for Implementing Enterprise Web Services (JSR 109)

» The jaxrpc-mapping-info deployment descriptor (JSR 109) provides
deployment time Java-to-WSDL mapping functionality. In conjunction
with JSR 181, JAX-WS 2.1 complements this mapping feature with
development time Java annotations controlling the mapping

Reference: [JAXWS]

Building SOAs with Web Services
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ESB and service composition patterns in Java

= Implementing the Enterprise Service Bus (ESB) pattern is
straightforward if SOAP is used as messaging format:

» Java standards for Web services support provide basic ESB support
(loose coupling, location transparency, message routing, etc.)

» Support for advanced ESB features such as mediation in numerous
commercial products and open source assets (via SOAP headers)

= Several alternatives for service composition:
» Write your own composition code
* Using JAX-RPC or JAX-WS for service invocation

» Business Process Execution Language (BPEL) support in Java
application/integration servers, both open source and commercial

» Use BPEL for programming-in-the-large and Java for
programming in-the-small

» Use jOpera, a composition framework developed by ETH Ziirich 4@}‘)‘3&
(not based on BPEL, defining its own composition language) READY
* http://www.jopera.org !]Opel’a

Process Support for Web Services:

Building SOAs with Web Services
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Module 2: Summary

established and proven

Web services reuse well- ’
concepts.

some WSDL, and | didn’t

I've already skimmed through
understand a single line.

= Having a solid XML background is halfway towards understanding
Web services

= The base Web services stack is now solid and well established

= The WS-l profiles are an important milestone on the way towards
real interoperability between implementations

= Basic security has been robust for several years, but more
sophisticated security standards are still emerging

Building SOAs with Web Services
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Building Service-Oriented Architectures
with Web Services

Module 3: Web Services Construction

Web services programming isn’t
fundamentally different from what
I've been doing with J2EE and XML.

| bet | can get some of these new
wizards and tools to do most of the
hard work.

Building SOAs with Web Services
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Module 3: Agenda

= Technology implementations
» Web services tools
» J2EE Web services implementations
» Other programming languages
= End-to-end example using open source technologies
» Introduction and getting started

» WSDL definition

» Service provider creation from WSDL

» Test service implementation

» Web service publishing and discovery

» Create a Web service client from WSDL

» Secure communication with SOAP/HTTPS

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Eclipse-based Web services tools
= Eclipse 3.3/3.4 Web Tools Project (WTP)  crmmmmmmmmmsmm ol
» Open source downloads from eclipse.org 51,0 0.0 & BN
Cr— x|
» Web services wizards, WSDL editor, - [peee————, =< [
WS- validator g‘:é‘:ﬂ: —
2 onﬁth;mp(ts e
» Focus for today S s
* J2EE - Eclipse Platiorm Cox i
Eie Edt Navigate Search Project Run Wndow Help - Clients
HrE&$-0-a 0% | Be |6 e s £ 02 mesouce bt [
END- R AL 1A 24
8 ProectExplorer 8 m — AR 1|
R s:.:::;:msem == 7 show Al wzards. 5 =
] = T
Efgzn;ﬁrmums ?:’\m [E5 Cal2 Web service method sk [ wext> || Fren Cancel
R Enterprise Applcatons] o— (=
P [ eo— | 5
G Servces = || () Services. ‘
= 2 Web Service Clent
BwsoL
b X
b (= Examples. L
e ¢ || = IBM Rational Application Developer
o — (RAD) 6.x and 7
.
» Based on Eclipse and WTP
S r— “ 2 » Plus many more Web services tools

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.




J2EE Web services implementations

= Apache Tomcat + Axis
» Open source download

» J(2)EE compliant Web container
plus SOAP engine with JAX-*
support B

» Basic administration tools

» Integration with Eclipse + WTP
Focus for today

BEEE e
al=

T B SERVER
ADMINISTRATION ToOL

IBM WebSphere Application Server

» J(2)EE compliant
ks _— » First class administration and
e ‘w clustering support
ebugLovet | [o.%
e | [ » Integration with RAD
URIEncoding: | |
T - » WS-Security, WS-AtomicTransaction,
Phrametss Service Gateway, SDO support
ewos + others

Building SOAs with Web Services
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Axis / Tomcat / J2SE compatibility matrix

Powered by Axis, Axis2 Axis 1.2 Axis 1.3 Axis2 1.2-1.4
J2SE 1.4.x 5.0 (1.5) Java 5
Tomcat 5.0.28 5.5.12 5.0 and higher
o = Tomcat 5.5.x requires J2SE 5.0, Axis 1.2 J2SE 1.4.x
g@ = Eclipse WTP 1.0 supports Axis 1.2, WTP 1.5 Axis 1.3;
S WTP 2.0 added support for Axis2 (new Axis code base!);
Java latest version is WTP 3.0

= The combination we use is Eclipse WTP 2.0 RC2, Axis2
1.2, Tomcat 5.0.28/5.5.26, and Java 5

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.
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PHP introduction

= PHP: Hypertext Processor

= Portable scripting language especially suited to Web development
= Open source implementation

= Embedded inline with HTML, Syntax similar to C / Java / Perl

= For simplicity, we have used the XAMPP implementation from
apachefriends.org
» Single distribution containing Apache, MySQL, PHP and Perl

» http://www.apachefriends.org/en/xampp.html

= SOAP support now native in PHP 5
» Service consumer programming easier than service provider
» Implementation in C provides good performance
» Also NuSOAP 0.7 from sourceforge.net for PHP4 clients

sOURCER. RGE
ohet

Building SOAs with Web Services
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Example introduction

= Taken from Perspectives on Web Services Chapter 4.11
» “Creating a document/literal Service from WSDL”
= Insurance scenario with a fictitious Insurer called
PremierQuotes
= Example shows how PremierQuotes generates a report on
the total risk under management by the company for a
government agency

Archie Tekt » Broken down by year
= XML schemas are defined to represent documents received
and returned from the service (standards body)
— = WSDL created which references the schemas
Zippy Coder

= Java service implementation created from WSDL (top-down)
by PremierQuotes

= Java service requestor created from WSDL by government
agency

= PHP service requestor and Ruby service provider created to
show interoperability

Ed U. Cate

Building SOAs with Web Services
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Web services architecture for insurance scenario
Government Service Requestor (Java, Stub-Based) Premier Quotes Mid Office
Service Provider (Java)
TestJSPs | | Glient cod
Browser (Eclipse WTP) e ode Servlet Engine SOAP Engine
(Tomcat) (Axis)
JAX-RPC/WS SOAP Engine HTTP Client InVOke
Stub (Axis, other) JAX-RPCIWS
Stub
Dssecr:-liie?on Server Code
Transport Infrastructure s(wsg:_) (POJO)
Bi nd Web (HTTP) Network Operating
r Server (TCP/IP) System
External Risk Assessment
Service Provider (other language)
Public Service Requestor (PHP, Stubless)
HTTP SOAP
Endpoint Support
Client |nVOke
Frontend Page| | pub 5 soap
pp! DsarvﬂlcT Server Code
HTTP Client ‘:;‘,’sg:_)"“ (Controller)

Building SOAs with Web Services
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Green thread through the development steps

= Step 1: Create WSDL service definition
» From scratch (top-down) or from existing asset (bottom-up)

= Step 2: Generate server-side implementation stub from WSDL
» WSDL port type mapped to Java interface and classes
» WSDL operations mapped to Java methods
» XML Schema (XSD) types mapped to Java value objects

= Step 3: Complete server-side implementation and test
= Step 4 (optional): register service into UDDI or other registry (publish)

= Step 5: Generate client-side invocation proxy from WSDL, write client
» Same WSDL to Java mapping steps as on server side

= Step 6 (optional): secure service on network, transport, message layer

Building SOAs with Web Services
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Getting started with Eclipse Web Tools and Tomcat

@ New Dynamic Web Project

N x|

= Switch to J2EE Perspective

‘@ . Create new Dynamic Web

Drectory: [ Ci\oaf\researchd
&'1ava (defautr)
& Java Browsing

- D ic Web Project
. ‘Open Perspective i
Create a standalone Dynamic Web project or add i to a new or existing Enterprise
Appication.
[ CVS Repository Explorir
(3 Database Debug Project name: | PremierMidOfficeWeb
[ Database Development | - project contents:
%5 Debug Use defaut
2 126E

project targeting Tomcat 5.0 /
J2EE 1.4 (or Tomcat 5.5)

» Create new Tomcat v5.0

TEGERITE Server during project creation
Te’3ava Type Hierarchy | |Apache Tomeat vs.0 Iv]
o oa pevelopment e » Define path to Tomcat
= = h . )
20 e omamic b roject ) ) X | installation directory
8°Te: | Project Facets @ » Select Axis2 Web Services
Select the facets that should be enabled for this project. facet in Project Facets
Configurations: |<custom> | [sae
& s e = Server can be started and
Project Facet Version .
0 R stopped from Servers view
e e B ot ] o o ]
[] 4 Java Persistence 1.0
[] & Javaserver Faces 12
[[] & webDoclet (XDoclet) 123 -
Problems | Tasks | Properties | 4 Servers 2 Conso\e| ’};{ Q l.; Z I Exy =8
Server | status | state |
= 2% Apache Tomcat v5.0 £ Stopped Synchronized
@ [ 4 % GovernmentClientweb
% PremierQuotesMidOfficeWeb

Building SOAs with Web Services
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Configuring the Eclipse Web services tools

= Selection of Web Services

] X]

Preferences available for
customisation
= Window -> Preferences
Menu
» Find Web Services entry
= Mandatory step: define
location of Axis2 runtime
= Optional step: modify
setting for the WS-I

& Preferences
type fiter text || Profile Compliance and Validation o
Team b/
Valdation WS-T AP complance level
Web and XML | suggest compiance [v]
5 Web Services WS- SSBP complance level
Axis Emitter —

Axis2 Preferences
Popup Dialog Selection
Profle Complance and !
Project Topology
Resource Management
Scenario Defaults
Server and Runtime
Test Facity Defauits
XDockt

[ r——

Select whether WSDL valdation should be performed on wizards that consume WSDL fies
(@ No wizard WSDL valdation
() Wizard WSDL validation for remote files onfy
(O Wizard WSDL vaidation for al WSDL fles

compliance, default is

@

=

“Suggest Compliance”
» WS- Attachments Profile
(WS-I AP)

» WS-I Simple SOAP
Binding Profile (WS-I SSBP)

Copyright is held by the au

WSl

INTEROPERABILITY

Building SOAs with Web Services
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Step 1: WSDL definition

Discovery
Agency

UDDI/ WSIL

UDDI/ SOAP
Inquiry API

UDDI/ SOAP
Publish API

Lt

Service Service
Requestor Provider

Lt

SOAP [ HTTP or other Transports

| Security |
| XML Namespaces | | XML Schema |
| XML Foundation |

Building SOAs with Web Services
Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Graphical WSDL Editor

= Create a new WSDL file RiskReport.wsdl using WSDL Editor
» Alternatively, you can import an existing file

P RiskReportPortService.wsdl &2 = OJ[Z= outline &2 =0
{*5 Imports
(= Types
& Services
4 RiskReportPortservice o) [ Orskeeporortiype | ¢ Bindings
© RiskReportPortService 4 getRi t (£ Port Type
http://127.0.0.1:80... ©1input | [7 riskReportRequestPart | [€] RiskReportRequest -} Messages
@output | F riskReportResponsePart | _[€] RiskReportResponse

Building SOAs with Web Services
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WSDL input and output message contents

= = Request contains two integer values to create report
eportRequestType; [&] RiskReportRequestType|

[€] riskReportRequestData  RiskReportRequestType [e] firstyear int
[e] noOfYears  int

= Response contains an array of annual reports, indexed by year

[E] (RiskReportResponseType)
[€] RiskReportResponseData  RiskRecordCollectionType

| [¥] RiskRecordColectionType ‘ [E] RiskRecordType
| [e] RiskRecordTypeData [0..%] RiskRecordType } [e] year int
[e] report  RiskAssessmentResultType

[&] RiskRecordType 2] RiskAssessmentResultType
[€lyear  int [€] policyCount int
[e] report  RiskAssessmentResuftType [&] totalCimValue double
“_[& daimCount int
[¢] totallnsuredvalue  double

Building SOAs with Web Services
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Step 2: Service provider creation from WSDL

Discovery
Agency UDDI / WSIL

UDDI/ SOAP
Inquiry API

UDDI/ SOAP
Publish API

Service
Requestor

SOAP [ HTTP or other Transports

| Security |
| XML Namespaces | | XML Schema |
| XML Foundation |

Building SOAs with Web Services
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Creating a WS-l compliant service in Java from WSDL

= Select WSDL

= Select Web Services ->
Generate Java bean
skeleton context menu

= Wizard based on Axis2
WSDL to Java command

line tool

© Web Service -
Web Services
Review your Web service options and make any necessary changes before proceeding &
to the next page.
Web service type: | Top down Java bean Web Service [v]
d [Premiertidc ice.visd
e oty
i ¢ B Server: Tomcat v5.0 Server
el () Web service runtime: Apache Axis2
‘Service project: PremierMidofficeWeb
@ 9
& Web Service
Clent type: ‘]ava Proxy Axis2 Web Java Bean

o cent

» Select Axis2 as Web

service runtime

=] c@

Configural
- Sevcenome  [RekReportportseves
Port ame [RekReportpotservcs
= Dotabidng Name 208
N = ]
) 2 ? Custom package name | com.premierquotes s report.rsk
[ Generate an Interface for Skeieton
LI Publsh the Web service [ Generate sl types for al eements referred by schemas
Monitor the Web service
] Do not show me this dialog box again. Namespace Package

» Optionally, define
custom mappings

'http://www.w3.0rg/2001/XMLSchema 0rg.w3.www._2001.xmischema
@ m
o

Generated code

JAX-RPC/JAX-WS Service Endpoint
Interface (optional) and

Value objects for message
parameters

Axis2 configuration

= Service deployment

= Updated web.xml

= Classpath updates
include Axis2 libraries

= Project deployed to server

= Server started

L

e i) RiskReportRequest java

Service Implementation Skeletc?

T

Building SOAs with Web Services
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[7) Project Explorer £ Bg§-°8
2 PremierMidOfficeWeb S
‘23 Deployment Descriptor: Apache-Axis2
= resources
8 src
= i oM. premierquotes.ns.reports.risk

gl ortService Out.java
> RiskReportPortServiceskeleton. java
= f# Com.premierquotes.ns.reports.risk.req

5] ExtensionMapper java

i) RiskReportRequestType java
= f# COM.premierquOtes.ns.reports.risk.resp
i) RiskAssessmentResuftType java
i) RiskRecordColectionType java
I RiskRecordType.java
I RiskReportResponse.java
=i JRE System Library [jdk]
=i\ Apache Tomeat v5.0 [Apache Tomcat v5.0]
i Web App Libraries
& buid
£ WebContent
¥ RiskReportPortservice.wsdl
axis2-web
METAINF

& 5 services
& § RiskReportPortService
& com

£ META-INE
e [ serviceslist
o [ versonaar
46 web.xml
£ buid xml
> resources
4 RiskReportPortService.wsdl
¥ services.xml

Building SOAs with Web Services
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Complete service implementation

package com.premierquotes.ns.reports.risk;

* RiskReportPortServiceSkeleton java skeleton for the axisService
*/

= To simplify this example

we have stubbed out the import com.premierquotes.ns. reports. risk. resp. i
service implementation public class RiskReportPortServiceskeleton |
. public com.premierquotes.ns.reports.risk.resp.RiskReportResponse getRiskReport (
with a random number com.premierquotes.ns. reports. risk. req. RiskReportRequest riskReportRequest0 ) {
System.out.println("## Started MidOffice riskReportRequest");
enerator
int noOofYears = riskReportRequest0.getRiskReportRequestData () .getNoOfYears ();
int firstYear = riskReportRequest0.getRiskReportRequestData().getFirstYear();
= Use generated data types
RiskRecordCollectionType resultArray = new RiskRecordCollectionType () ;
and package names from
. // loop for each year requested
Axis2 WSDL to Java for (int i=0;i < noOfYears; i++)
RiskRecordType rec = new RiskRecordType ();
= Book example based on rec. setYear (first¥earti);
RiskAssessmentResultType report = new RiskAssessmentResultType();
Cloudscape / Derby DB report.setClaimCount ( (int)Math. round (Math. random() *100.0)) ;

report.setPolicyCount ( (int)Math. round(Math.random()*10000.0)) ;

report.setTotalClaimValue (Math.rint ((Math.random()*1000000.0)*

= Note: Axis emitter report.getClainCount (1) / 100.0) ;
. . . report.setTotallInsuredValue (Math.rint ((Math.random()*10000000.0)*
interface different in IBM report.getPolicyCount () / 100.0)7

WAS/RAD rec.setReport (report)

resultArray.addRiskRecordTypeData (rec);
b

= Note: Axis and Axis2 use RiskReportResponse resp = new RiskReportResponse ()
- . resp.setRiskReportResponseData (resultArray) ;
different interfaces System.out.println("## Completed MidOffice riskReportRequest");

return resp;

Building SOAs with Web Services
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Step 3: Test service implementation

Discovery
Agency

UDDI/ SOAP
Inquiry API

UDDI/ SOAP
Publish API

binding and
implementation

| Security |

| XML Namespaces | | XML Schema |

| XML Foundation |

Building SOAs with Web Services
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Web Services Explorer

= Test service implementation from WSDL definition — no coding
= View Form or Source of results

@ Web Services Explorer 3
Web Services Explorer

 Web Services Explorer X

Web Services Explarer

% Navigator

o8 Actions

i Smws

4& WSDL Main

2 m——

122 RiskReportPortService

E1/®] RiskReportSOAPBinding
Y. rsepor]

- !
5 2 fiex/C:folf pons/pas/premierid| | & Invoke 3 WSDL Operation

Enter the parameters of this WSDL operation and click Go to invoke.
Endpoints

+ RiskReporRes ponse

- Dat

‘ http://localhost:8080/PremierMidOfficeVWeby/services/RiskReportPortSery

+ RiskRecond TypeDaia

~ RiskReportRequest
v riskReportRequestData
firstYear int
2006

noofyears int

year {iny): 1999

- report
policyCount (inj: 6946
ol Claim Value (double): 204815.34
chaimCount (int): 79
wtallnsured Value fdouble): 6.309171169ET

+ RiskRecond TypeData

year (int): 2000

i status

- report

IWAB0388I Endpoints were successfuly updated.

Bl =

WABO3811 file:/C:/olaf/pows/pqws/PremierMid OfficeWeb/WebContent/wsg

policyCount (i) 9945
tolal Claim Value (double): 16967941

] claimCount (int): 89

TCP/IP Monitor

S Preferences
type filter text TCP/IP Monitor (SR |
= Internet [a]
Cache Configure TCP/IP monitors on local and remote ports.
Proxy Settings [¥ Show the TCP/IP Monitor view when there is activity
ava
Opera TCP/IP Monitors:
Piug-in D
I Ruf /Debug Status | Hostname | Type |LocalPort |  Add... .
Console ! Started localhost:8080 HTTP 8081 =
External Tooks
Launching Remove

@ New Monitor

X]

Monitor

Local monitoring port: | 8081 =

TCP/IP Monitor X

Building SOAs with Web Services
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Creates a new TCP/IP port
which listens on requests and
responses and forwards to
another address

» Local or remote
Integrated WS-I Compliance
checking for SOAP messages

~ [ locahost:8081

Host name:
| | port:

Type:

Timeout (in miiseconds): |0

Time of request: 7:14.9.515 PM

o Response Time: 365 ms
focalhost T
ES = | =
Request: localhost:8081 = < Response: lo
HETR i Size: 491 (888) bytes |—U Size: 1563 (1703) bytes
= Header: POST / by /RiskReportPortSe Header: HTTP/L.1200 0K

<soapenv:Envelope xmlns:g0="http
<soapenv:Body>
<g0:RiskReportRequest>

Show View -> Other menu
= Under Debug category

<g0:riskReportRequestData>

. <g0:no0fYears>4</q0:no0fYears> <RiskRecordTypeData>
= Enable thrOUgh Window -> </q0:TiskReportRequestData> <year>1999</year>
</q0:RiskReportRequest> <report>

</soapenv:Body>
</soapenv:Envelope>

://pre <?xml version="1.0" encoding="UTF-8"7> |*

irstYear»>1899</q0: firstYe

<soapenv:Envelope xmlns:soapenv="http:
<soapenv:Body>
<RiskReportResponse xmlns="http://pr
<RiskReportResponseData>

<policyCount>2626</policyCount>
<totalClaimValue>455368.1</total
<claimCount>73</claimCount>
ctatalTnsuradValnesa 421R32707F7 |7

Kl [

L] [ [ [+]

Building SOAs with Web Services
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Step 4: Web service publishing and discovery

Discovery
Agency

e ————
binding and
implementation

SOAP [ HTTP or other Transports
| Security |
| XML Namespaces | | XML Schema |
| XML Foundation |

Building SOAs with Web Services

or/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Copyright is held by th

Publishing with WS-Inspection

5 = Generate and update WS-
| X] .
WSIL Import = Inspection Language (WSIL)
Import WSDL references to a WSIL document \:‘04 documents
= Browse and import services

WSIL URI: | /PremierMidOfficeWeb/\WebContent/wsd}/RiskReportPortServicewsl ~ Browse

WSDL:
& Web Services Explorer i3 =g

http://localnost:8080/Prem Web Services Explorer

‘- Navigator g Actions
/SIL Main -
R wsIL Main) ® Open WSIL

Add Remove

Enter the URL of a WSIL document or a HTML document and click Go to open inspect.

URL to document:
http://localhost:8080/PremierMidOfficeVWeb/wsd|/RiskReportService.wsil

Choose the type of objects to inspect:
Go | Reset =

i Status

http://localhost: 8080/ Premier Mid OfficeWeb/wsdl/RiskReportService.wsi

Building SOAs with Web Services
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Publishing with UDDI
B

Web Service Publication

Do you want to publish your Web service? 1 Cl ?

[+ Launch the Web Services Explorer to publish this Web service to the Unit Test UDDI Registry
[ Launch the Web Services Explorer ta publish this Web service to a UDDI Registry
Public UDDI Registry |51 UDDI Test Regis

D) X
Unit Test UDDI Registry Configuration
Mext > _ Fll @ nwAB0363E No UDDI registry available. 1
@ Deploy the Unit Test UDDI Registry
= UDDI Publish feature in Eclipse Private UDDI Regitry type: | =]
Web TOOIS InC|UdeS references  Update the previously deployed DD registry
to “Unit Test” UDDI Reg|stry  Remove the previolsly deployed DO regisiry
» Local J2EE UDDI
Implementation R Fah concel
» Not shipping with WTP, but
packaged with WAS/RAD

Building SOAs with Web Services
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Step 5: Creating a Web service client from WSDL

Discovery
Agency UDDI / WSIL

UDDI/ SOAP
Inquiry API

UDDI/ SOAP
Publish API

L
Service
Provider
Lot
SOAP [ HTTP or other Transports
| Security |
| XML Namespaces | | XML Schema |
| XML Foundation |

Building SOAs with Web Services
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Creating a Web service client in Java

& Web Service Client -
.
Web Services §
& Web Service Client
Review your Web service options and make any necessary changes before A
proceeding to the next page. Axis2 Client Web Service Configuration
Service deiton: | /Premridoft e tportserviceavsd! | (51 the appropriate Codegen settings
Clet type 3avz Proxy Service Name. | RskReportportservice [v]
Port Name | RskReportportservice [v]
Deploy clent @S
: Databinding Name |a0B [v]
& Server: Tomeat v5.0 Server et = - ——
ustom e name Com.premierquotes.ns.eports.ris
o \Web service runtime: Apache Axis2 25 DI = J
(o — -
Client project: Go tClientweb
= fent proj vernmentClentWet ot o
(® Generate both syncand async (O jeonly O Generate /le only
o TSR [] Generate test case to test the service
[[] Do not show me this dialog box again. [ Generate all types for al elements referred by schemas
Namespace Package
, ‘com. ns.reports.risk
p com. ns.reports.fisk.resp
@ < Back Next > Finish Cancel L p rg.xmk hemas.wsdl.soap
http://vnni.w3.0rg/2001/XMLSchema org.w3.w._2001xmischema
eq m. ns.reports.fisk.req
http://schemas.xmisoap.org/wsdl org.xmisoap.schemas.wsdl

= Create Java JAX-RPC/JAX-WS
client from WSDL into a Web project

= WSDL namespace to Java package ® <ok
mapping (optional)

Building SOAs with Web Services
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Generated client-side artefacts

[ Project Explorer &3 E&°=0
% GovernmentClientWeb ~
‘&3 Deployment Descriptor: Apache-Axis2
gBerc

= [# com.premierquotes.ns.reports.risk

= JAX-RPC/JAX-WS 1) RiskReportPortServiceCalbackHandler java

. . ___—» = {1 RiskReportPortServiceStub.java
Service Endpoint Interfface — | =0 Beepotpotsenasiy
1 1 @ RiskAssessmentResult’
(optional) and service L ipme
roxy/stub  RekRecordrype
p y \ {¥ RiskReportRequest
= Value objects for message B & Rty
parameters i —
4o faultExceptionNameMap
4o faultMessageMap

= Classpath updates include & RaReporthonsenEeSt0
. . . & RiskReportPortserviceStub(String)
AX|32 ||bra ries & RiskReportPortserviceStub(ConfigurationContext, String)

fromOM(OMElement, Class, Map)
getEnvelopeNamespaces(SOAPENvelope)
getRiskReport(RiskReportRequest)
optimizeContant(QName)
populateAxisService()

populateFaults()
setOpNameArray()

tartgetR i tRequest, R jceCalbackHandler)
toEnvelope(SOAPFactory)
toEnvelope(SOAPFactory, RiskReportRequest, boolean)
toOM(RiskReportRequest, boolean)
toOM(RiskReportResponse, bookean)

= Project deployed to server
= Server started

EsEmommmnE%h

Building SOAs with Web Services
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Creat'ng a C“ent import com.premierquotes.ns.reports.risk.RiskReportPortServiceStub;

public class RiskReportClient {
public static void main(String[] args) {
if (args.length != 2) {

. System.out.println( "Usage: RiskReportClient <first year> <no of years>");
= Create a new Java client ratuzn;
with a main() method Ly
called RiskReportClient RiskReportPortServiceStus sei - new RiskReportPortServiceStus
] Implement USlng the ("http://127.0.0.1:8080/PremierMidOfficeleb/services/RiskReportPortService");
generated Service // populate request with passed values
. com.premierquotes.ns.reports.risk.RiskReportPortServiceStub.RiskReportRequestType data =
Endpoint Interface and new com.premicrquotes. ne . Teports. iok.RiskReportPort Sorvi ceStub. RiskRepor tRoquest1ybe )
Service Locator (AXIS) data.setFirstYear (Integer.parselnt (args[0]));
. It data.setNoOfYears (Integer.parselnt(args([1]));
and Service Stub (AXISZ) com.premierquotes.ns.reports.risk.RiskReportPortServiceStub. RiskReportRequest req = new
" com.premierquotes.ns.reports.risk.RiskReportPortServiceStub.RiskReportRequest () ;
OnCe Complete! use req.setRiskReportRequestData (data) ;

Run -> Run ... menu

// invoke the service

» Add program com.premierquotes.ns.reports.risk.RiskReportPortServicestub.RiskReportResponse resp =
arguments <first sei.getRiskReport (req);
com.premierquotes.ns.reports.risk.RiskReportPortServiceStub.RiskRecordCollectionType
year> <no years> recordscoll = resp.getRiskReportResponseData () ;
com.premierquotes.ns.reports.risk.RiskReportPortServiceStub.RiskRecordType[] records =
» eg. 19995 recordscoll.getRiskRecordTypeData () ;
. . // loop through each record printing results to console
= Note: Axis emitter for (int i-0; i < records.length; is4) (
H f A System.out.println ("REPORT FOR " + records(i].getYear() + " :");
interface different in IBM Rt
WAS/RAD com.premierquotes.ns.reports.risk.RiskReportPortServiceStub.RiskAssessmentResultType

result = records[i].getReport();

System.out.println("Total # policies =" + result.getPolicyCount());

" Note: AXIS and AX|52 use System.ou[.prlntln(::Totsl # claims ) + result.getClaimCount ());
e A System.out.println("Total value of policies =" + result.getTotalInsuredvalue());
dlfferent Intel'faceS System.out.println("Total value of claims =" + result.getTotalClaimvalue());:

System.out.println (" "
}

} catch (Exception e) {
e.printStackTrace () ;

Building SOAs with Web Services
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Creating a Web service client in PHP 5

= PHP SOAP extension provides a simple to use class called SoapClient
» Create a new instance, passing WSDL URL as a parameter
» Call the WSDL operation directly, passing in an array of parameters
» Extract data from returned structure and populate table
= Copy PHP file into XAMPP /htdocs directory — invoke from browser
» Check file permissions

<?php
/* Display Risk Report */
function displayRiskReport ($firstYear, S$years) ({
try {
$soapClient = new SoapClient(
"http://localhost:8080/PremierMidOfficeWeb/services/RiskReportPortService?wsdl") ;

/* Retrieve the report */
$rrPart->firstYear = $firstYear;
$rrPart->noOfYears = $years;
$rr->riskReportRequestData = $rrPart;
$rrResponse = $soapClient->getRiskReport ($rr);
$rrReturn = $rrResponse->RiskReportResponseData;
} catch (SoapFault $soapFault) {
echo $soapFault, "<br/>";

Building SOAs with Web Services
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Step 6: Secure communication with SOAP/HTTPS

Discovery
Agency

UDDI/ SOAP UDDI/ SOAP
Inquiry API Publish API

UDDI/ WSIL

binding and
implementation

| XML Namespaces | | XML Schema |

| XML Foundation |

Building SOAs with Web Services
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Securing a Web services implementation on Tomcat with SSL
= Use the J2SE keytool command to create a certificate keystore with a
self-signed certificate using the RSA algorithm
» The keystore contains certificates used by the server
» The truststore contains certificates trusted by the server

» <JAVA_HOME>/bin/keytool -genkey -alias tomcat -keyalg RSA
-keystore <TOMCAT_HOME>/conf/.keystore

» Complete questions when prompted

= Edit Tomcat configuration file in local workspace (not Tomcat install dir)
» Java Perspective: Servers -> Tomcat @ localhost-config -> server.xml
» Remove comments and specify as follows

<-- Define a SSL Coyote HTTP/1.1 Connector on port 8443 -->

<Connector className="org.apache.coyote.tomcat5.CoyoteConnector™
port="8443" minProcessors="5" maxProcessors="75"
enableLookups="true" disableUploadTimeout="true" acceptCount="100"
debug="0" scheme="https" secure="true"; clientAuth="false"
sslProtocol="TLS" keystoreFile="/opt/tomcat-5.0.28/conf/.keystore"
keystorePass="your_ password"/>

= Restart and open the Tomcat home page using https://localhost:8443
= Update client code to reference keystore/truststore and HTTPS URL

Building SOAs with Web Services
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Module 3: Summary

Web services programming isn’t
fundamentally different from what
I've been doing with J2EE and XML.
| bet | can get some of these new
wizards and tools to do most of the

hard work.

= For both simple and sophisticated Web service development, you can
rely on tools support plus some basic Java programming skills

= The Eclipse Web Tools project provides all of the features you need
when using the basic Web services building blocks (SOAP, WSDL,
and UDDI)

= Both Axis2 and commercial tools and runtimes support specifications
like WS-Security, WS-BPEL, or WS-ReliableMessaging

Building SOAs with Web Services
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Module 4a:
Putting the A back into SOA -
Architectural Decision Modeling Wiki

How can SOA decisions be identified, made, and enforced?

All these options to implement
SOA... has anybody done it before?
If so, how?

Decisions and outcome are obvious...
just put the right people on the project,
they know better anyway.

Building SOAs with Web Services
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Module 4

Grady Booch in his SW Handbook blog (October 2006)

= “IMHO, SOA's value proposition begins with the A in its acronym:
architecture”

» “There are many things we already know about what constitutes a good architecture and
what does not. Stripped away of all the hype, a Service-Oriented Architecture is essentially
a variant of well-proven message-passing architectural patterns. The variance comes in
the form that services are cleverly designed to take advantage of the Web-centric
infrastructure that pervades many organizations: services allow you to send and receive
semantically rich messages through firewalls.”

» “What distinguishes a good service from a bad one? what should the granularity of a
service be? when should | offer up a stateless service versus a stateful one? as for the
stateful ones, how to | express their semantics, and how do | ensure their their misuse
doesn't corrupt my system? how do | express the semantics of a society of services (only
the most trivial services work in isolation)? how do | decide upon the semantics of the
information transmitted by these services so that locally they are efficient and useful but
that also globally they are consistent? how do | expose some services to some clients and
hide them from others? how do | offer up variants on a service, so that different clients see
a different face to that service? how do | ensure the security of critical services, such that |
am confident I'm not opening up holes in my enterprise that will let the bad guys in? what
services should | expose to the world, and what services should | keep hidden? where are
services appropriate, and where are they not? how do | best expose services in a legacy
system? who should own/maintain these services? are there alternative architectural
patterns | should employ instead of services, and where, and why?”

Building SOAs with Web Services
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Module 4

How to structure and share answers to these questions?

= Patterns...
= Methodologies...

= Reference architectures...

= ... do not provide sufficient answers to these and other architectural
decisions:

» Presentation layer
* Rich vs. thin client, Web 2.0 vs. plain HTML, etc.
» Business modeling interface and process (service composition) layer
» Process modeling and execution language, control flow, data flow
» Integration layer
» ESB technology and product selection, configuration

Building SOAs with Web Services
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Module 4

SOA Decision Modeling (SOAD) in a nutshell

= Technical decision identification,
making, and enforcement often Decision S
disconnected, leading to cost, Making Enforcement
quality, and risk mitigation issues
* One-of-a-kind transaction,
security, and reliability
design (no reuse) SOAD Project] WikPage | User Setings | _Help

SOA Decision Modeling

- Gaps between logical and oot Treneection tanagement Patter —
physical models, LOBs, B e
presales and post sales | =
| = e
= SOAD provides innovative method, & S ot o
content, and tools for end-to-end e E— e el
decision maker collaboration and EM IRTJL“WR‘“"”'””:'"; )

“This pattern comprises of e primitves PAT-N, PT-SNT. CWT-CS, ST-N

best practices exchange:
» SOA decisions, patterns,

Pros
Reasonabla siza of ansaction

and policies continuum L
* Reusable, machine- L e
readable decision models St e ([ e
» Web 2.0 tool support st o e 2007012414810 bt

Building SOAs with Web Services
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Module 4

Architectural decision modeling for reuse [QoSA 2007]

= Architectural decisions @ ArchitecturalDecision {AD)
. . ° index : UnlimitedNatural
capture key design issues = name ; String
along with the identified O i e S
g : ; ° name : String . 2 pane] Smmgsn o problemStatement : String
@ shorthame ing o refe + St
alternatives and their o descrpton s Sung (o, | ¥ | » cecoonOrvers : g
tradeoffs, as well as the 2 recommendatn ; Strng
a
. . Lo a ble : Rok *
rationale behind a design: L < entfcey - Aok
= identifiedWhen : Timestarmp.
©Role i
. . . 9 name : String 1 &
» Conscious design decisions lependsOn (a4
concerning a software system w Sy
© ADAlternative
asa whole, or one or more of ©Pattern e S ——
its core component > name : Sting = assumptors : Sting
@ Technology 5 description : String 1 5 designModeR eference : Component
» Determining the non- g MO cecieor S Y
H iot o + St o talerBy : Rok
functional characteristics and © hsset o knownilees © Sting o takerWhen : Timestamp

quality factors of the system

= Documenting architectural decisions should be state of the practice

= Using pre-populated AD models in an active, guiding role is a novel approach
» Our work is based on existing work and ongoing research e.g. by Philippe Kruchten

Building SOAs with Web Services
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Module 4

Examples for SOA design issues: Process realization

16 Business event triggering this
business process: customer enquiry,

requesting upgrade from prepaid to a
regular services. 20.0% Yes
>

62 Data and error flow, update location(s)
and transaction management policy not
specified on this level of abstraction -
single distributed system transaction?
BPEL compensation? What to do if
recondilation fails?

Message format?
Message exchange pattern?
Transport protocol?

Rich client, thin client, or RIA as
presentation layer?
If business process is executable, in b
which BPM/workflow engine? .

(Read Operation) (Write Operation) Wireline LOB)

@ @ @
Retrieve Wireless % : Upgrade Wireless % : Reconcille Profile
Customer Frofile Customer Profile Upgrade (With

1) S0A middleware connects the service composition layer (above) with atomic services and ental
responsilities:
- Basic Web services connectivity and deployment management (WSDL, SOAP), transport protoy
- Service composition container (BPEL, SCA)
- Transaction management and resource manager coordination (WS-Coordination, WS-Atomic!

. It has the following

Which EAI/ESB to use?
Component interface and

= 0 iretess customer profles and wireline | implementation technology?
RNs'are three different enterprise. |
Wireless resources, all of which are accessed - g
Customer concurrently by multple processes. Wireline LOB Wireline LOB
Profile The wireless customer profiles are CRM System 1
Bepcsitorny transactional database resources; the (e
(Prepaid, wireline CRM systems only provide |__Customers) |

ular)

non-transactional messaging interfaces.

= Solution architects concerned with many questions regarding process transactionality,
protocols, product selection/configuration, logical and operational modeling, etc.

Building SOAs with Web Services
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Module 4

Layered SOA reference architecture and SOA decisions

{5 Driverosa2sample?

{i BusinessExecutiveLevel

L. . {o ConceptualLevel

= Decision space orgamzed by |ayers of a {{]EnterpriseApplicationArchitectureDecisions

[ LeyertResourceRealizationDecisions

SOA reference architecture (o teverzComponertRealitionoessions CoNcepts

=

» IBM SOA Solution Stack by default [IBM SSS] T e g

» Other ones possible {LsyersintegrationrealizationDecisions
p e

{LsyerainformationManagementreslizationDecisions

{ij operationalModelingConceptuzlbecisions

{5 TechnologyLevel

{i enterpriseApplicationDesignDecisions

s

é_ [} LaveriResourceTechnologyDedisions

?; { Layer2tavabesignDedisions

82 g {JLaverascapesignecisions

223 {i LaverarestfullntagrationDecisions Technol ogy
i ‘

§§ g €+ LaveraBpelModelingDecisions

8

{id Laver6integrationTechnologyDecisions
{iLaverManagementDecisions
{i Laver7SecurityTechnologyDecisions:
{ie] Laver8informationlntegrationDesignDecisions
{i OperationalModelingSpecificationDecisions

= VendorAssetievel

" Reflnement dependenC|es from Conceptual ") EnterpriseApplicationDeploy mentDecisions

{i Layer2lavabDeploymentDecisions

to technology to vendor asset level [ LayeraScaDeploymentDecisions Assets
» Process layer: workflow concepts, BPEL

raBpelDeploymentDecisions

technology, IBM Process Server product asset [ aerswebDeploymentDacisions
| verrsecurtyassas
» Same for integration Iayer: messaging, ESBs {]LaversinformationintegrationAssetDecisions

{J 9perationalModelPhysicalDecisions

Building SOAs with Web Services
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Module 4

Collaboration tool support: Layered application Wiki

Source- i
Component Collaboration Component El S E—
o Management-
Content =L View
Repository Domain Layer 9 mporUExpor
XPOrt-
| Dependency Management Component | § View
Persistence | Decision Workflow Component | = Presentation
=
Layer Versioning and Reporting Component o Layer
7}
= Decision-
RDBMS | Import/Export Component | = WorkflowView
Q
. c
Server- ErrorHandlingComponent 3 Collaboration-
Component LoggingComponent > View
0
SecurityComponent - NavigationView

Building SOAs with Web Services
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Module 4

Rationale for using an application Wiki as SOAD Front end

= Decision drivers:
» User experience, small footprint, support for collaboration use cases, API

= Architecture alternatives and their pros and cons:
» Rich user experience, e.g., via Eclipse plugin
» Only way to share information is via version control system or
import/export
» Plain HTML
» Small footprint, but content has to be managed centrally
» Plain wiki

» Self-governing content management, but content lost in presentation
layer

» Application wiki
» Benefits of Wiki plus server-side APIs for automated processing

Building SOAs with Web Services
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Module 4

Benefits of model-driven decision capturing

= Overcome shortcomings existing knowledge management approaches
» Existing practices (structured text templates) lack precision and do not scale

» Existing decision guides focus on single sub domain/scenario and jump from concepts
straight to assets (or start at asset level)

= In line with stepwise refinement concept in Rational Unified Process and IBM
Global Services Method

» Three levels of refinement for component and operational modeling work products
» Decision models bridge the gap between these concerns

= Structured way of stating best practices
» Bound to architectural context: decision drivers, design model
» Big picture preserved via decision relationships

Building SOAs with Web Services
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Module 4

Summary of benefits and novel contributions of SOAD

= Time savings
= Risk mitigation
= Quality improvements

= Active, guiding micro-methodology
» Anticipating required decisions, giving concrete advice

» Complementing Rational Unified Process (RUP), Service Modeling and
Architecture (SOMA), and IGS Method

= Model-driven approach to AD capturing
» Reusable ADMs replacing text tables

= Best practices bound to architectural context

Building SOAs with Web Services
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Module 4

Module 4b:
SOA and Web Services Best Practices

Which are the pitfalls to be avoided during service design?

that we can be sure to deliver in time

We have to manage expectations so ’
and on budget.

mistakes made by the very early
adopters of this technology.

We don’t want to repeat all the

This module is excerpted from the book “Perspectives on Web
services” by Olaf Zimmermann, Mark Tomlinson, and Stefan Peuser,
Springer-Verlag Berlin Heidelberg New York 2003, ISBN 3-540-
00914-0. This work is subject to copyright. © Springer Verlag 2003.
All rights reserved.

Building SOAs with Web Services
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Module 4

Module 4b: Agenda

= Usage scenarios for Web services
» Business litmus test
» Technical litmus test

= Architectural decisions
» Addressing non-functional requirements
» Gaps and countermeasures

= Best practices
» SOAP, WSDL, UDDI

» SOA in general

= Questions and answers session

Building SOAs with Web Services
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Module 4

Web services — holy grail or déja vu?

= SOA concepts and Web services technologies have been used
successfully to address the following requirements:

» Automation through application clients

» Connectivity for heterogeneous worlds

» Information and process sharing

» Reuse and flexibility

» Dynamic discovery of service interfaces and implementations
» Business process orchestration without programming

= Additional advantages include:
» Non-invasiveness of the technology
» Productivity boost and industry momentum
» Standardisation and openness
» Low project risk

Building SOAs with Web Services
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Module 4

Usage scenarios

Service
Integration

Complex
Level P

Business \

Processes

H EAl B2B =
Business
Functions

(Use Cases)

Technical Ve !

~
Functions
& Common Services (CS)
Information
Services hS i i )
Simple Intranet Extranet Internet 3
Service
Reach

= Plus: EDI replacement, portal adaptors, competency-focussed organisations,
mobile device communication, RMI/IIOP substitute, file transfer, grid computing ...

Building SOAs with Web Services
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Module 4

Take the business litmus test — are Web services for you?

= |If you answer “Yes” to any of the following business questions,
consider using Web services:

» Do you want to interact with your business partners in a more
automated fashion?

» Is there a requirement to connect stovepipe applications/packages?
» Do you want to make legacy assets available for reuse?

» Looking for a more flexible IT architecture that can easily adapt to
change? (agility / competitiveness / responsiveness)

» Is your system environment heterogeneous?

= Note that there is a place for both Web services and more
“traditional” EAl approaches. They also complement J2EE.

Building SOAs with Web Services
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Module 4

The technical litmus test

= |f you answer “Yes” to any of the following technical questions,
consider using Web services:
» In your use case model, are other systems the primary actors in your
system?

» Do you have to support a heterogeneous or unknown client
environment?

» Do you plan to extend the reach of J2EE applications to application
clients?

» Do you already transfer XML documents via HTTP-GET or -POST?

» Do your rich application clients use proprietary communication
channels and are your firewall administrators unhappy about this?

» Does the number of service providers in your environment vary?

» Is your existing infrastructure capable of handling a rather verbose text-
based, self-describing message exchange format?

Building SOAs with Web Services
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Module 4

Addressing potential inhibitors

= The following are the most typical inhibitors to adoption. Most can be
overcome:

» Over-enthusiastic expectations

» Goal conflicts

» General scepticism regarding maturity of new technology
» Security and performance concerns

» Logistical and organisational issues

» Skill deficiencies

» Roll-your-own temptation

= The exact ROl and TCO is often difficult to determine up-front

Building SOAs with Web Services
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Module 4

W3C WSA solution architecture

(Service Tier)

(Client) Rich Client Web uDDI
Applicati icati Browser
Service Discovery Agency
Proxy Proxy (UDDI, WSIL)
HTTP SOAP
Client Client
Provider UDDI Discovery Agency

HTTP Server
Web Container

| SOAP Server |

Web Service Implementation
Business Logic

| JDBC |

HTTP

Server
SOAP uDDI
Server Web App

J2¢ proprietary
Adapter Adapter

Provider (Database)

Provider (Backend EIS)

| RDBMS |

| ERP | | RYO |

DDI
Business Logic
uDDI
Database

Building SOAs with Web Services
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Key architectural decisions which must be made

C Architectural Decisions

Service SOA
i in general
SOAP Agency
Runtime Type

Provider
Implemen-

O
OV

WSDL
Creation

Gateway,

Type
tation Requestor
Type

Deployment

System
Architecture,

Security
Architecture

Management
Operations

Accounting
Billing

Session
Management

Building SOAs with Web Services
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Module 4

Handling non-functional requirements (NFRs)

= Performance

» Ensure that requirements are realistic

» Build a small prototype at start of project to check if criteria can be met
Scalability

» Design your services to be as stateless as possible

» Normal J2EE scaling strategies can be applied
= Availability
» Normal J2EE availability strategies can be applied
* Robustness
» Create an effective error handling mechanism with SOAP fault handling
» The product building-blocks are now mature enough for prime-time
= Portability

» Stick to agreed industry standards/specifications such as JAX-RPC,
where they exist, and be prepared for changes (JAX-WS)

Building SOAs with Web Services
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Module 4

Gaps and countermeasures

= The XML language binding and encoding maze
» WSDL and SOAP do not define any language bindings
» Adhere to the WS-I Basic Profile 1.1, use (wrapped) document/literal
= Security solutions
» Network Layer security (IPSec, VPNs)
» Transport Layer and Application Server security (Basic vs. Keys)
» XML-based security (XML-Signature, XML-Encryption, SAML)
» WS-Security and it's additional specifications (WS-Policy, WS-Trust etc.)
» Or Application Layer security if all else fails
= Web service management approaches
» Look for SOAP runtimes which have JMX instrumentation
» OASIS Web Services Distributed Management (WSDM)
= Transactional and context semantics plus orchestration
» Still emerging: WS-Coordination, transaction support, WS-BPEL

Building SOAs with Web Services
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Module 4

Best practice highlights I: WSDL and modeling

Follow a meet-in-the-middle WSDL
design approach

Generating WSDL from server side
Java can be a good idea, if you make
sure no programming language
specifics make it into your interface.
This provides a jump-start for beginners.

Follow the design-by-contract
principle

Always describe your services using
WSDL and XML schema. Add comments
for human consumption, and put the
documents on a Web server. Consider
developing your own WSDL generator if
many similar processes need to be
supported.

Building SOAs with Web Services
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Module 4

Best practice highlights 1l: SOAP and messaging

Carefully observe the messaging
overhead

Also known as SOAP verbosity. The
overhead can be three to 20 times,
depending on the naming conventions
and the nesting levels of the document.
Use TCP monitors and try different
Include, but do not rely on, the HTTP | runtime parsers/engines.

SOAP action header

This should not be used for routing
purposes — this should be based on the
namespace attribute of the body element.
The feature is now deprecated, but
certain SOAP engines might still expect it
to be present.

Building SOAs with Web Services

Copyright is held by the author/owner(s). OOPSLA 2008, October 19-23, 2008, Nashville, Tennessee, USA. ACM 978-1-60558-220-7/08/10.

Module 4

Best practice highlights Ill: UDDI and matchmaking

Carefully evaluate which type of UDDI
registry is suited for your scenario

Using UDDI on the Web is problematic for
organisational reasons. UDDI can be useful
in intranet and extranet scenarios where the
user groups are well known. However, the
APl is rather complex to use. Defining
specific tModels and UUIDs may relieve
some of the data consistency and trust
issues.

Building SOAs with Web Services
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Module 4

Best practice highlights 1V: SOA and project approach in general

Apply standards pragmatically:
follow the 80-20 rule

Do not always use all of the features in
each and every specification. Upgrade
to high specification levels only if there
is a concrete need, not for its own sake
Resist the temptation to be over- (e.9. SOAP 1.1 vs. 1.2). The 80-20 or
creative “keep it simple” rule helps with
interoperability.

Do not implement your own SOAP layer;
any Roll-Your-Own (RYQ) approach
compromises the Web services value
proposition. Let the vendor labs and open
source community worry about the
runtime, otherwise RYO is likely to
become rewrite your own (every time).

Building SOAs with Web Services
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Any questions?

Building SOAs with Web Services
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If you don‘t have questions for us... we have some for you

Which business challenges does the demonstrated sample SOA/Web
services solution address?

Which core Web services specifications were involved? And where?
Where in the practical demonstration was the ESB?
Same for service composition?

Could you identify any familiar design patterns in the generated JAX-RPC
artifacts?

Apart from function and parameter names, what does the interface contract
agreed between GovernmentOffice and PremierQuotes have to define?

What information is required to get the Web services enablement project
started?

Building SOAs with Web Services
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Optional exercise: Customer Information (Cl) Service

Install Eclipse Web Tools Project

Start from a Java class providing a customer information method:
» In parameter: name

» Out parameters: email address, areas of interest

Apply Java-to-WSDL wizards to create Web service provider
Apply WSDL-to-Java wizard to create invocation stub for test client
Test the Cl Web service with Web Services Explorer

Compose risk report and customer information service into one
service

» Custom code or jOpera

Building SOAs with Web Services
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Check out our Web site — www.soadecisions.org

rves o8
e as

Perspectives on Web Services
Zmmermarin / Tominson / Peuser

| Home | About the Book | About the Authors | Order the Book | Download Area | Impressum | Contacts | Links |

Olaf Zimmermann, IBM Global Services, Germany,
Mark Tomlinson, IBM Software Graup, United Kingdam,
Stefan Peuser, 1BM Global Services, Germany

Perspectives on Web Services

Applying SOAP, WSDL and UDDI to Real-World
Projects &
Perspectives on

This book is designed as a full and rich source book for Web Services "I certainly wish I'd
architects, developers and project managers of Web had this book at my
services projects. disposal, for it would
have definitely made my

The book is writtn by experienced practitioners. The text is Jife o whole lot easier.”

accompanied by a realistic case study which leads the
reader through a complete project lifecycle. J2EE and the
IBM WebSphere product family serves as the sample
implementation platform for the intraduced concepts.

Grady Booch, Chisf
Scientist, IBM Rational

Wtho Should Read this Bogk?
ey Topics
About the Authors
Ordering Information
Download Area
About the PremierGuotes Group
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Additional Materials for Handouts
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Handout Material

Tomcat & Axis install

= Tomcat 5.0/5.5
» Extract Tomcat
» Add admin/manager user to XML configuration
» Tomcat homepage is http://localhost:8080
= Java Activation Framework (JAF) 1.0.2 and Java mail library
» Download JAF from Sun site might be required (Axis prerequisite)

» Copy mail.jar and activation.jar to tomcat/common/lib directory, and
add these libraries to client project build path
= Axis 1.2/1.3 (earlier versions of this tutorial)
» Ships with Eclipse WTP 1.0, so no need for additional installation steps
» Optional: run Axis validation to check if any dependencies are missing
= Axis2 1.2 (2007)

» Binary image has to be loaded into Eclipse via Window ->
Preferences... (under Web Services and then Axis2 Preferences)

Building SOAs with Web Services
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Handout Material

Eclipse Web Tools install

= |nstall Eclipse 3.3/3.4
= Launch ./eclipse
= |nstall Web Tools Project (WTP) via Eclipse update manager (or
manually):
» Select Help, then Software Updates, then Find And Install...
» Click on Search for new features to install, click on Next
» Create a New Remote Site... for WTP, pointing to
http://download.eclipse.org/webtools/updates
» Select WTP 2.0 and all required prerequisites
» Perform the installation
= Create workspace
= Create Tomcat 5.0/5.5 server configuration
= Start and stop server to check configuration

Building SOAs with Web Services
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Handout Material

RiskReport.wsdl — WSDL used in example (1/4)

<?xml version="1.0" encoding="UTF-8"?>
<wsdl:definitions name="RiskReport"
xmlns:impl="http://premierquotes.com/ns/reports/risk"
xmlns:req="http://premierquotes.com/ns/reports/risk/req"
xmlns:resp="http://premierquotes.com/ns/reports/risk/resp"
xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/"
xmlns:wsdlsoap="http://schemas.xmlsoap.org/wsdl/soap/"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
targetNamespace="http://premierquotes.com/ns/reports/risk">
<wsdl:types>
<!-- Schema definition for request document -->
<schema xmlns="http://www.w3.0rg/2001/XMLSchema" elementFormDefault="qualified"
targetNamespace="http://premierquotes.com/ns/reports/risk/req"
xmlns:reg="http://premierquotes.com/ns/reports/risk/req"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<complexType name="RiskReportRequestType">
<sequence>
<element name="firstYear" type="xsd:int"/>
<element name="noOfYears" type="xsd:int"/>
</sequence>
</complexType>
<element name="RiskReportRequest">
<complexType>
<sequence>
<element name="riskReportRequestData" nillable="true" type="req:RiskReportRequestType"/>
</sequence>
</complexType>
</element>
</schema>

Building SOAs with Web Services
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Handout Material

RiskReport.wsdl — WSDL used in example (2/4)

<!-- Schema definition for response document containing year and data -->
<schema xmlns="http://www.w3.0rg/2001/XMLSchema" elementFormDefault="qualified"
targetNamespace="http://premierquotes.com/ns/reports/risk/resp"
xmlns:resp="http://premierquotes.com/ns/reports/risk/resp"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<complexType name="RiskAssessmentResultType">
<sequence>
<element name="policyCount" type="xsd:int"/>
<element name="totalClaimValue" type="xsd:double"/>
<element name="claimCount" type="xsd:int"/>
<element name="totallInsuredValue" type="xsd:double"/>
</sequence>
</complexType>
<complexType name="RiskRecordType">
<sequence>
<element name="year" type="xsd:int"/>
<element name="report" nillable="true" type="resp:RiskAssessmentResultType"/>
</sequence>
</complexType>
<complexType name="RiskRecordCollectionType">
<sequence>
<element maxOccurs="unbounded" minOccurs="0" name="RiskRecordTypeData" nillable="true"
type="resp:RiskRecordType"/>
</sequence>
</complexType>

Building SOAs with Web Services
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Handout Material

RiskReport.wsdl — WSDL used in example (3/4)

<element name="RiskReportResponse">
<complexType>
<sequence>
<element name="RiskReportResponseData" nillable="true"
type="resp:RiskRecordCollectionType"/>
</sequence>
</complexType>
</element>
</schema>
</wsdl:types>

<!-- Input and output messages -->
<wsdl:message name="riskReportRequestMsg">

<wsdl:part element="reqg:RiskReportRequest" name="riskReportRequestPart"/>
</wsdl:message>
<wsdl:message name="riskReportResponseMsg">

<wsdl:part element="resp:RiskReportResponse" name="riskReportResponsePart"/>
</wsdl:message>

<!-- Port type - links messages and operation -->
<wsdl:portType name="RiskReportPortType">
<wsdl:operation name="getRiskReport">
<wsdl:documentation>Returns a collection of risk reports for the period specified
</wsdl:documentation>
<wsdl:input message="impl:riskReportRequestMsg" name="riskReportRequestMsg"/>
<wsdl:output message="impl:riskReportResponseMsg" name="riskReportResponseMsg"/>
</wsdl:operation>
</wsdl:portType>

Building SOAs with Web Services
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Handout Material

RiskReport.wsdl — WSDL used in example (4/4)

<!-- Binding - defines invocation style and encoding for port type -->
<wsdl:binding name="RiskReportSOAPBinding" type="impl:RiskReportPortType">
<wsdlsoap:binding style="document" transport="http://schemas.xmlsoap.org/soap/http"/>
<wsdl:operation name="getRiskReport">
<wsdlsoap:operation
soapAction="http://premierquotes.com/ns/reports/risk/getRiskReport"/>
<wsdl:input name="riskReportRequestMsg">
<wsdlsoap:body use="literal"/>
</wsdl:input>
<wsdl:output name="riskReportResponseMsg">
<wsdlsoap:body use="literal"/>
</wsdl:output>
</wsdl:operation>
</wsdl:binding>

<!-- Port - defines endpoint for a specified binding -->

<wsdl:service name="RiskReportPortService'">
<wsdl:documentation>Example Risk Reporting Service from Perspectives on Web Services
</wsdl:documentation>
<wsdl:port binding="impl:RiskReportSOAPBinding" name="RiskReportPortService">

<wsdlsoap:address
location="http://localhost:8080/PremierMidOfficeWeb/services/RiskReportPortService"/>

</wsdl:port>

</wsdl:service>

</wsdl:definitions>

Building SOAs with Web Services
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<?xml version="1.0" encoding="UTF-8"?>

xmlns:uddi="urn:uddi-org:api">
<service>
<abstract xml:lang="en-US">
</abstract>
<description referencedNamespace="http:
location="RiskReportPortService.wsdl"

impl:RiskReportPortService
</wsilwsdl:referencedService>
</wsilwsdl:reference>
</description>
</service>
</inspection>

Handout Material

RiskReportPortService.wsil — WS-Inspection file

<inspection xmlns="http://schemas.xmlsoap.org/ws/2001/10/inspection/"
xmlns:wsilwsdl="http://schemas.xmlsoap.org/ws/2001/10/inspection/wsdl/"
xmlns:wsiluddi="http://schemas.xmlsoap.org/ws/2001/10/inspection/uddi/"

//schemas.xmlsoap.org/wsdl/"
>

<wsilwsdl:reference endpointPresent="true">
<wsilwsdl:referencedService xmlns:impl="http://premierquotes.com/ns/reports/risk">
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Trademarks

AmberPoint is a trademark of AmberPoint, Inc.

Amazon is a registered trademark of Amazon.com, Inc. and its
affiliates

Apache Tomcat, Axis and Xerces are trademarks of The Apache
Software Foundation

BEA is a registered trademark of BEA Systems, Inc.

CBDl is a trademark of CBDI Forum Limited

CORBA is a registered trademark of the Object Management Group,

nc.
DCE is a trademark of The Open Grou
D-U-N-S® is a registered trademark of Dun & Bradstreet
Corporation.
eBay is a registered trademark of eBay Inc.
Eclipse is a registered trademark of the Eclipse Foundation
GLN is a trademark of the Uniform Code Council Inc.
Google™ is a trademark of Google Technology Inc.
HP is a registered trademark of Hewlett-Packard Development

Company, L.P.
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Rational XDE, Redbooks, SOMA, VisualAge, WebSphere®, all
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the United States, other countries, or both.

|IETF is a trademark of The Internet Society

lona is a registered trademark of IONA Technologies

Linux is a registered trademark of Linus Torvalds.
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Windows® NT, and Windows® 2000 are either registered
trademarks or trademarks of Microsoft Corporation in the United
States, other countries, or both.
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Classification Policy Committee, Statistics Canada, and
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Informatica

OASIS is a registered trademark of OASIS Open

OMG is a registered trademark of the Object Management Group, Inc.

Perl is a registered trademark of the Perl Foundation

PHP is a registered trademark of the PHP Group

Red Hat® is a registered trademark of Red Hat, Inc.

SAP and R/3 are trademarks or registered trademarks of SAP
Aktiengesellschaft.

SourceForge is a trademark of the Open Source Technology Group

Sun, Sun Open Net Environment, Sun ONE, Solaris, Java and all Java-based
trademarks (e.g. EJB, J2EE, J2SE, JavaBeans, Java Connector, JCA,
JDK, JVM) are trademarks or registered trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Thoughtworks is a registered trademark of ThoughtWorks, Inc.

UDDI is a trademark of OASIS Open

UNSPSC is a trademark of United Nations Development Programme (UNDP)
and Dun & Bradstreet Corporation (D & B)

UML is a registered trademark of the Object Management Group, Inc

UNIX® is a registered trademark of The Open Group in the United States and
other countries.

W3C® is a registered trademark of the Massachusetts Institute of
Technology, European Research Consortium for Informatics and
Mathematics, or Keio University on behalf of the World Wide Web
Consortium.

WS-| is a trademark of The Web Services-Interoperability Organization

XAMPP is a registered trademark of Apache Friends

Yahoo! is a registered trademark of Yahoo! Inc.

Other company, product or service names may be trademarks or
service marks of others
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